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Introduction
PicturesToExe Deluxe is the program, which can help you to create splendid slide shows,
consisting of almost limitless number of pictures in EXE file or SCR format (screensaver). The
interface of PicturesToExe Deluxe is very easy in use, both amateur PC users and professional
photographers and people of all specialities can work in this program without any difficulties.
PicturesToExe Deluxe supports different formats such as JPG, GIF, BMP and EXE, which is the
main for this program. A slideshow in EXE format can be reproduced on any computer under
Windows XP, Vista, 95, 98, Me, 2000, 2003. No additional program (even PicturesToExe itself) is
needed to run a finished slide show, except a produced EXE file.
You can place any objects (images, text labels with drop shadows) on a slide and customize
complex animation. It`s either possible to use various cinematographic transition effects between
slides, to add backgroud music, sound and text comments to a slide. You can also synchronize
slide shows to music. Slide show has a high picture quality and a very smooth playback of
Pan/Zoom effects you have ever seen.
VideoBuilder in PicturesToExe Deluxe edition allows you to burn DVD video disc with your slide
shows quickly and easily. You can adjust menu and many other parameters of your DVD disc. You
cannot but notice one more advantage, PicturesToExe gives you an opportunity to create AVi
video file. If you think, it`s necessary you can protect your slide show with password and assign
expiration date. Burned in PicturesToExe DVD video disc can be played on any DVD player, PC
or MAC.

Main features
PicturesToExe produces a single EXE file which contains all pictures and music.
PicturesToExe Deluxe can burn DVD-Video disc with slide shows.
Pan/Zoom/Rotate effects for images.
A powerful editor of objects of the slide with possibility to adjust complex animation.
You can add buttons or text labels with drop shadows and glows to a slide.
Cinematographic transition effects between slides.
The show of slides can be exactly synchronized to music on the timeline with waveform.
Slide show has a built-in player for high quality MP3 and OGG playback. It also supports
WMA, WAV and MIDI music playback.
Ability to create a screensaver.
Navigation bar in the slide show.
An easy solution of creating greeting cards.
Ability to create AVI video file.
Supports a multi-select and visual drag-n-drop between the file panel and the slide list.
Supports sound comments to the slides (MP3, OGG, WMA or WAV).
Images can be in JPEG, PNG, GIF or BMP format.
Ability to rotate pictures (lossless algorithm).
Every slide can be individually customized with its own time, effect, background, and etc.
Supports English, Russian, Netherlands, Italian, Swedish, Hungarian, Slovenian, German,
Catalan, French, Spanish, Arabic, Romanian, Chinese, Brazilian Portuguese, Danish,
Czech, Ukrainian, Slovak languages.

System Requirements
For slide shows with Pan/Zoom effects:
PC with 1.4 GHz CPU, 256 MB of system memory, video card with 128 MB of video memory.
Windows XP, Vista, 2000, 2003, Me, 98 or 95. DirectX 8.1 or later.
For slide shows created with simple effects:
PC with 500 Mhz CPU, 64 Mb of system memory, any video card. Any version of Windows.
System requirements for PicturesToExe and VideoBuilder:
PC with 500 Mhz CPU, 64 Mb of system memory, any video card. Windows XP, Vista, 2000, 2003,
Me, 98, 95. Note: burning of DVD-Video discs in VideoBuilder requires Windows XP, Vista, 2000.

What`s New in PicturesToExe
Encoding of DVD-Video disc (and AVI) works in 2-4 times faster now due to the optimization
of dual-core CPUs and using of hardware acceleration for video post-processing (if modern
video card installed). Exactly the same video quality as in previous version.
You can choose a number of items per page in DVD menu.
MPEG2 files can be added to a project. For example, you can encode your slideshow(s) to
MPEG2 video file(s) and then use it again in the new projects without re-encoding it again.
Music for DVD menu (with "Fade in" and "Fade out" parameters).
Color adjusting of DVD menu (Hue, Saturation and Lightness). It allows to modify the view of
DVD menu and to find your own individual style very quickly.
Adjusting of background image parameters (Tile, Stretch, Fit).
Supports all kinds of AVI files imported to the project (including AVS video file scripts).
A new tab in the Project options window - "Program" (customizing priority mode for encoding
and temp folder).
More exact calculation of required disc space.
"Wait for a key press to show next slide" option in Project options is available again. You can
overwrite global value in properties of a slide.
Adjusting of colors for Text/Button objects in hover and pressed states activated again.
PicturesToExe starts much faster now.
Timeline window remembers the current position of a cursor and the selected keypoint when
you switch between the Timeline window and the main window of PicturesToExe.
Supports multi-line default text comment for all slides (Project options / Comments tab).
Visual improvements in Music tab of Project options and Customize slide windows. You can
visually re-arrange files in the playlist.
The Slide list shows a hint what to do, when no slides are added.
Fixed bug with too large controls in Drop shadow dialog when 120 dpi graphics mode used.

Questions
What are the system requirements for slide shows?
For slide shows with Pan/Zoom effects:
PC with 1.4 GHz CPU, 256 MB of system memory, video card with 128 MB of video memory,
Windows XP, Vista, 2000, 2003, Me, 98 or 95, DirectX 8.1 or later.
For slide shows created with simple effects:
PC with 500 Mhz CPU, 64 Mb of system memory, any video card, any version of Windows.
How can I register PicturesToExe?
Please open this page: http://www.wnsoft.com/apr
I bought PicturesToExe vX.xx. Should I pay again for next versions?
No, you needn`t pay for PicturesToExe again and you can use all future versions of PicturesToExe
free of charge. Your license for VideoBuilder in PicturesToExe Deluxe is intended for two years
and you can buy "Upgrade to Deluxe" again to continue using VideoBuilder and being able to burn
DVD-Video discs.
I don’t have an opportunity of downloading the program from the Internet. How can I
purchase it on CD?
You can purchase CD with PicturesToExe from Barry’s Beckham web site:
http://www.beckhamdigital.co.uk/digitalav/pte/pte.htm
What screen resolution is needed to view the presentation?
You can use any resolution: 800x600, 1024x768, 1280x1024 or higher. A slide show in EXE file
uses a current display mode. All elements of a slide scale are visible automatically and
proportionally at any display mode.
Will PicturesToExe create presentations that can be viewed on Apple Macintosh computers
(Mac OS X)?
You can't run EXE file with a slide show on MacOS. But you can burn DVD-Video disc in
PicturesToExe Deluxe and additionally put EXE files of slide shows. Thus DVD-disc will play with
highest quality on PC (as EXE file) and as DVD-Video on Mac computer.
Can I put my slide shows (EXE files) created with PicturesToExe to CD or DVD discs?
Yes, of course!
How many slides can I include into my slide show?
Up to 20000 slides (unregistered version limits to 10 slides).
What is the largest size that the generated EXE file can be?
The resulting EXE file cannot be larger than 2100 MB (2 GB).
What additional files are needed to run the EXE file of the slide show on my computer or
any other computer?
No other files are necessary to run the EXE file.

PicturesToExe v4.48 had the transition from/to desktop effect. I can’t find this effect in
PicturesToExe 5. Why?
We removed "Show transition effect from/to desktop" options in a new version of PicturesToExe for
two reasons:
This effect doesn't work correctly under Windows Vista due to error in Windows Vista. Slide shows
created in v4.48, in which this option is used, will work as though they are created without these
options.
There is a problem even with Windows XP. Since version 5.0 we use a fullscreen hardware
accelerated display mode (for maximally smooth playback of Pan/Zoom effects) and these options
could work incorrectly on some video cards.
Those are the reasons why we decided to remove these options.
Where can I download the examples of slide shows created with PicturesToExe?
You can find our slide shows at http://www.wnsoft.com/download.htm and a lot of slide shows
created by users of PicturesToExe at http://www.beechbrook.com/pte.

Problems
I lost PicturesToExe (PC crash etc.). How can I turn the program back without being
charged again?
You can download the latest version of PicturesToExe from:
http://www.wnsoft.com/apr/apr-deluxe.zip
You can request a new register key at the technical support web page:
http://www.wnsoft.com/support.htm
Autorun doesn't work.
There are many reasons why it may not work:
1. Probably CD autorun is forbidden in Windows system.
2. These inf file and slide show exe file should be in the root of the CD.
I have launched PicturesToExe, but the interface language looks unfamiliar. How can I
switch English (or another) language?
Open the fourth menu from the top panel of PTE window. Select the third line and then switch the
necessary language from the list.
When I try to open/save one of my projects, it says that the images are not found.
This problem may be caused if you remove or replace any files (images, music), while making a
project or after saving a project. You shouldn’t remove or replace any files used in a show from
their original folders, because the program keeps in memory each file’s path in order to find it next
time when you open your project.
When I create a show, my images look normal, but when I play a created presentation, color
gamma of these images is much brighter.
By default we use a hardware accelerated screen mode in v5.00. It allows us to reach ideally
smooth Pan/Zoom effects. This mode, used in Media Center, Chess Game and Aero Glass uses
interface in Windows Vista.
Unfortunately drivers of ATI video cards for Windows XP contain a bug. It ignores color gamma
settings in this fullscreen mode which you adjust for the desktop. ATI has already fixed this bug for
their drivers for Windows Vista and they also promise to fix it for Windows XP later.
As a temporal solution go to Project options -> Screen tab and uncheck "Use hardware
acceleration" option. But if you use Pan/Zoom effects it will not play smoothly enough.
You can complain to ATI and ask them to fix this bug as soon as possible:
http://support.ati.com/ics/survey/survey.asp?deptID=894&surveyID=486&type=web
Zoom/Pan transitions are “jerky” and not smooth.
1. Make sure that your video card satisfies the requirements of these effects.
2. Perhaps, the size of your images is too big. Try to reduce it and preview the show once again.
This is the link to our free program, which helps you to reduce the sizes of all images at once:
http://www.wnsoft.com/soft/MultiResize.exe (216 KB)
3. If the show still has a bad quality, please, report about it to the technical support. We would be
grateful, if you indicate your computer configuration and write a detailed problem description in
your ticket:http://www.wnsoft.com/support.htm

I lost pictures which were used in a show. How can I turn them back?
You can’t extract images from exe files. We refused to add such ability to the program, because
many customers don’t want other people to be able “stealing” their copyrighted pictures. We can
only advice you to make screen shots of the images and save them.
Slide show hangs on a certain slide, but music continues playing.
Please, check if some of your slides have customized settings: right mouse click on a slide and
select Customize Slide menu item.
Grabbed music “stutters”.
PicturesToExe is very sensitive to any errors in audio files, which may appear while grabbing or
converting.
We can advise you to use "Exact Audio Copy" program to grab music from CDs. This program is
free.
DVD burning can’t be completed correctly: the progress stops, Video Builder says the disk
is full, recorded disc doesn’t play in a DVD player.
1. Make sure that your disc is not full.
2. Do you use high quality DVD discs? Please, try to use another disc and try to record once again.
If the program does not respond or you face any error messages, please, report to technical
support service.
I burned DVD-video disc, but it doesn`t play smooth.
Before burning DVD-video disc, check TV system parameters in the project options. If you live in
the USA, Canada or Japan, choose NTSC. If you live in Europe, you should choose PAL/SECAM.

How to...
How to upgrade PicturesToExe to Deluxe edition? I want to burn DVD-Video discs with my
slide shows.
If you bought PicturesToExe v4.48 or earlier or you bought PicturesToExe Standard edition you
can upgrade to Deluxe edition and use VideoBuilder to burn DVD-Video discs:
https://www.regnow.com/softsell/nph-softsell.cgi?item=16393&ordertype=Upgrade%20to%20Deluxe
How can I make my slide show (EXE file) to start just after inserting CD or DVD discs into
the drive?
Create new document with the name "autorun.inf" using any text editor (e.g. Notepad) and write
the following text:
autorun]
open=YourSlideshow.exe
icon=YourSlideshow.exe
(Note: instead of "icon=YourSlideshow.exe" you can write "icon=YourIcon.ico") where
"YourSlideshow.exe" is a file name of your slide show. This file ("autorun.inf") must be copied to
the root of CD or DVD disc with your slide shows.
EXE file of my slide show is too large. How can I reduce the size of my EXE file?
Reduce your JPEG images to 1024x768 or 1280x960, 160-500 KB
Use MP3 files for background music (don't use WAV music files)
You can control the size of your slide show, watching the status bar at the bottom of the main
window (3rd section - 'EXE file - 4 MB')
How can I calculate the size of a produced EXE file with my slide show?
The size of your EXE file with slide show is 280 KB plus size of your files (images and music).
How can I synchronize several groups of slides with a certain audio track?
To synchronize a group of slides with an audio track, do the following steps:
select the necessary number of slides, drag the last one and set it exactly under the blue line,
which shows where the last track ends and the next one begins. Keeping these slides selected,
click <Timed Points> button and select "Arrange selected points". As a result, all these slides on
that area will be set on equal distance one from another. Then add next group of slides to the time
line: click <Insert slide> button, select necessary images and click <Add> button. And do the same
steps with them.
How can I fade music in the end of each track?
PicturesToExe doesn’t have audio editing abilities. You can make fade effects with any audio
editor and then add this track to a slide show.
I want to add one or more MP3 music files to my slide show as background music.
Go to Project options, Music tab and add music files (MP3, WMA, OGG, WAV, MID) which will play
in your slide show. Note: after the last file ends, the first file will be played again and so on.
How can I create an independent video file (not on CD/DVD) and save it on my hard drive?

You can create a custom AVI file:
Click <Video> button, check "Create custom AVI file", then select audio and video codecs: <Audio
codec> and <Video codec> buttons. You can choose any video codec, but "PicturesToExe video
codec". You can select codecs from the lists or use your own codecs. Then click <Create AVI>
button and save your file.
How can I make a screensaver and set it for my computer?
Create a slide show as a screen saver. Save it in any folder of your computer. Make a right click on
it and select menu item to set it as a screen saver for your PC.
How can I transfer my PicturesToExe to another computer?
You can copy PicturesToExe to any removable media (CD, flash memory device etc.) and then
install to another PC. Then register it with your current key. If you don’t have back-up copy of your
registration key, you can always turn to the technical support, and you will be given a new key:
http://www.wnsoft.com/support.htm
How can I avoid black strips at the top and at the bottom of the screen in my slide show?
If you watch any wide screen slideshows (say 16:9) on usual LCD display at 1024x768 (4:3), you
will see black strips at the top and the bottom parts of the screen. If you don't want to see these
black strips and you would like to use all square of your display for a slideshow, use "Pan and
Scan" feature of PicturesToExe. Create MyShow.bat file in Notepad and type:
"MyShow.exe" - Cover
See the result below:

It works for all EXE files with slideshows created in version 5.0 and later.You can distribute a ZIP
archive with your slideshow with EXE file and additionally include .bat file for fullscreen version:
MyShow_Widescreen.exe
MyShow_PanAndScan.bat

Quick Start - PicturesToExe
If you want to make the slide show, do the following steps:
1. Open PicturestoExe;
2. Open the necessary folder with the images from the directory tree of files;
3. Add the selected images to the slide list;
4. Then Customize slide and add Object and Animation to it, if you wish, in the preview
window;
5. After that, customize your slide show in the Project Options;
6. If you want to preview your slide show, click the button Preview and after that make some
changes, if necessary.
7. Your last step is to create the EXE file with your slide show by clicking the button Create.
That is the way for creating the simpliest slide show and EXE file.

Quick Start - VideoBuilder
If you want to burn DVD-video disc with your created slide shows, do the following steps:
1. Click Video in the Control Buttons panel of the PicturesToExe and select Burn DVDvideo disc;
2. Add the necessary projects to the project list and click Next;
3. Customize the menu of your disc by choosing the background and adding music to it and
press Next,
4. After that, select the place on your computer for saving temporary files and ISO image of
your disc and click Start for burning the disc.
That is the easiest way to burn DVD-disc with your projects.

Main Window Menu
As you can see, the main window menu consists of a number of smaller windows and icons.They
are:

1. the main menu;
2. the drive selector;
3. the directory tree of files;
4. the selected file in the directory tree;
5. the preview window for a selected slide;
6. the control buttons for a selected slide;
7. the slide list;
8. the control buttons;
9. the status bar.

Main menu
At the top of the main window you can see drop menu:


file menu;



project menu;



slide menu;



view menu;



help menu.

File menu
File menu has the following options:


The New – this option is used to open a new project.



The Open – is used to open earlier saved projects.



The Save and the Save As will help you to save
created projects under its own or new names.



The Create Backup in ZIP – this option will help you to
make all your projects in ZIP format. It`s helpful for
making reserve copies of your slideshows if you want to
save them and then take them to another computer.



The Templates – this option provides you to save
existing projects and to use them as the templates
while creating next slideshows. Opening this feature will
bring you to another dialogue box the Manage
Templates and the Create Template from this Show.
The Manage Templates means to save projects in one
directory file and then to use them in creating a new
slideshow with the settings saved in templates (The
Create templates from this Show).



The Create Slideshow and the Create Slideshow As are two options, which help you to
create exe files and save them under different names. The Create Slideshow and Run
means to create exe file and run it immediately after its creating has been finished.



The Create Screensaver helps you to create your slideshow in scr file. You may use your
slideshows in this format as animated screensavers.



The Preview option is used to preview your slideshows from the beginning up to the end
before creating it.



The Burn DVD-Video Disc option is needed to put created slideshows on DVD or Video
discs and then run them in DVD players or other computers.



The Create AVI-File option means to make AVI-File and then customize it in other editing
programs.



The Exit option allows you to exit PicturesToExe.

Project Menu
Project Menu consists of such options as:



The Undo and Redo options will help you to make some
changes while creating your slideshow.

Actions on File List - this option goes to the selected file in the directory tree. With the help of this
option you can select or unselect all pictures at once and add them to the slide list. It will save your
time as the work will go more quickly.


The Customize Startup Window, the Timeline option and the Project Options will be
described thoroughly further (see Projects Options, Main Tab p. 37).

Slide Menu
Slide Menu has a number of options, which are related to the slide itself and its characteristics.

images won`t be modified.



If you want to Copy, Rename, Remove Slide
from Slide List or Clear Slide List you should
use the necessary buttons.



Other options such as Customize Slide,
Objects and Animation are related to the
characteristics of the slide. They are needed to
adjust the slide and will be described further (see
Customize Slide p. 23 and Object and
Animation p. 27).



You may Rotate your slides clockwise and
counterclockwise with the help of consequent
buttons. It is important to note, that it is a virtual
rotation in PicturesToExe and the initial files with

View Menu
View Menu provides options, which will help you to adjust your main window:



The File List Sort Order is used to choose the necessary
order of your files according to the name, extension, date
or size and so on.



If you click on Advanced Options, the following dialogue
box will be opened:

Here you can see different options:

Path and Name of Sound Editor helps you to insert the location and the name of any sound
editor you wish.
Lossless Compress BMP Images helps to compress images of BMP format.
Slide List: Show File Names Only gives the view of the slide list only with names without
any thumbnails and additional information not to interfere.
New Style of Mouse Wheel (X Wheel) gives you an opportunity to scroll any window you
choose without clicking on it. This option is very helpful and saves your time.
Selecting the feature the Load Last Used Project is necessary, if you want the last project
open automatically, when you open PicturesToExe. It`s very convenient, if you work at one
project for a long time.
The option Enable PTE Program Sounds, if switched on, will work when certain functions of
the program are used.
Use Hardware Acceleration in Editor and Video should be selected for the better quality of
using animation effects, but if you have not very good graphics card, you`d better switch this
option off.

Show real slide in mini-player and Show real slide in Slide List are two options, which
help you to see the real size of the slide (the size like in the slide show) consequently in the
preview window and in the slide list.
Show Dialog on Video Button, Create DVD on Video Button, Show AVI Window on
Video Button are three options, which are used to create DVD and AVI files. If you choose
the first option, the dialog box with two DVD and AVI buttons will appear. If you choose the
second or the third option, DVD or AVI button will be shown. It depends on your choice.
The next two options Customize Slide on Double Click and Objects and Animation on
Double Click may be chosen depending on your preference and frequency of usage of
these two features.


The Language option includes more than twenty languages.



You may also choose among three views of the main window: Classic, Horizontal and
Vertical Views and the views of File Panel and Slide List.



There is also one option, which will be described in details further. It is Timeline option. Here
you can see such functions as:
Here you can choose between
styles of the Auto Scroll, to select
the color of the Waveform and
some other functions.

Help Menu
This option gives you an opportunity to find answers on all your questions and to see how different
options may function.

The Directory Tree of Files
The drive selector and the file directory tree is represented on the left side of the main window.
It`s an ordinary window, where all directories and files of
your computer are arranged on different drives. It`s very
convenient to choose among them and to look for the
necessary directory or file. When you choose the interesting
directory and double click on it, this file will appear in the
window for a selected file in the directory tree.

Above the window, which is on the right, you can see several icons. What do they mean?
this is the feature for regulation the size of the images in the selected file;
this icon changes the file directory tree to a full screen window, where you can see all files and
images more clearly;
this icon gives you a short way to go to the file My Documents;
this icon gives you an opportunity to go up to one level while searching for the necessary
image.

Preview Window for a Selected Slide
When you click on the necessary image in the file directory tree, it will appear in the Preview
Window for a Selected Slide.Here you can see the chosen image and some of its control buttons.


Main image shows the current
position of chosen by you file.



In the Comment box you can write
any suitable comment to the image.
If it`s not very convenient to you to
write in the comment line, you can
click on the icon next to the line, the
dialog box will appear and you can
write any comment. You will see this
comment on the very slide you have
chosen.



In the Add sound box you can add
the necessary sound file to a certain
slide. If you want to add music or
some sound commentary, you
should double click on the icon
beside the sound line and the dialog
box, where you can choose the
sound file, will open.

Below the main image you can see
timeline bar, where you can preview
the slide show. On the left from the
timeline bar there is the display,
which shows the position of the
current slide. On the right you can see the total time of the slide show.




Here you can also see two buttons Play/Pause and Stop. Play button is used to begin the
preview of your slideshow in a small preview window. This button plays two roles: Play and
Pause. If you click on Play it will turn
Pause and vice versa. When you click on Play, the
blue triangle will stand at the beginning of the timeline and will move to the right on the bar.

Here you can also see two buttons: Customize Slide and Objects and Animation. They are used
for adjusting each slide, which you choose and which appear in the preview window. These two
functions will be described in details further (see Customize Slide p. 23 and Object and
Animation p. 27).

The Slide List
The Slide List is the place in the main window, where all slides, which are selected for the slide
show, are situated. It`s important to note, that all slides are set up in a certain succession, and you
can move slides by dragging them in the necessary direction. You can add images in the slide list
in several ways:


by double clicking on the image in the selected file in the directory tree;



by clicking on the image and then clicking on the button Add, which is situated in the Control
Buttons panel;



by dragging the image with the help of the mouse, in this case it will look in a such way.
As seen from the figure, keep clicking on
the image and drag it to the necessary
place. The black line behind the image
shows the place where this image will be
set.

If you want to make some actions on the chosen slide in the slide list, you should right click on this
slide and the following box will appear:


You can Copy, Paste, Remove the slide or Clear
the Slide List.



With the help of the next three buttons you can
change the order of images in the slide list. You can
Move the selected image to Top or End, you may
choose Random Order of images.



Option Rename allows you to rename the image
and give it another name or title.



Start Preview from the Current Slide means that
you can see the slide show not from the beginning,
but from the chosen by you slide. It`s convenient, if
you want to see some effects or transition from one
slide to another and you don`t have to wait till that
very slide.

It`s necessary to note, that this menu has the same
options as some of the drop menu and control buttons.

It`s just more convenient and quick to use this box while working at the slide show, because all
necessary options and functions are gathered together.

The Control Buttons
With the help of the window The Control Buttons you can perform different actions and create the
slide show. Here you can see the following buttons:



Create button is used when you have finished to customize your slide show and want to
create it as an exe file. This format is very convenient, if you want to replace this slide show
to another computer or just keep it as an exe file in your own computer. You should
remember, that if you make some changes in the slideshow and then you press Create
button, the last exe file will be rewritten. So if you want to save both exe files, the first and
the second variant, you should use option Create Slideshow As... .



Preview button allows you to preview the whole slide show from the beginning up to the
end. If you want to preview it from some chosen by you slide, you should use the button,
which is found by Preview.



When clicking on Project Options, a large dialog box with numerous options and settings
for your slide show will appear. A detailed description of this button you can find further
(see Projects Options p.37).



Video button will help you to create a DVD-video disc or an AVI-file. It depends on what
you need. This feature will be described later (see Video Options p. 55).



Timeline option is necessary for synchronizing images to music. On clicking this button you
will see timeline window, where you should do all adjustments. This function will also be
described in more details further (see Timeline Operation p. 51).



Add, Remove and Clear List buttons are related to the slide list and are used to add new
images, remove unnecessary ones and to clear the whole slide list.



The explanation of icon was given earlier in the article about the directory tree of files.

The Status Bar
At the very bottom of the main window you can see the status bar:



The first word «Modified» means, that there were some changes made in your project. If
you save these changes, this word will disappear.



The next box shows the file size of the main image of the current slide.



In the third box you can see an approximate size of your exe file after creating it.



Further you can see the directory where the selected image is situated.



There is one more point in the status bar, which is also very important – Hold Time Points.
The default is, that this option is unchecked here. The meaning of it is, that if you add new
images to the slide list, the other images are moved to give space for the new image on a
certain number of seconds, which you have set for showing each slide. But if the option
Hold Time Points is checked, the images will not be moved and the slide will be added
without adding the space for it.

Customize Slide
If you click on the button Customize Slide in the preview window the following dialog box, where
you can see three tabs: Main, Effect and Music Tab, will appear.

Timing
Options Timing, Background and Advanced
Options are found in the Main Tab. Timing
includes the following features:


Display slide for (sec.) - here you can put the
number of seconds and milliseconds and this
image will be on for a desired period of time.
You can also use up and down arrows for
setting the time.



Scale keypoints in objects (on time change)
is the option, which spreads the slides upon
the new timeline. If you change the time of
showing for the slide, and this option is
unchecked, the time will be changed only for
new slides. But if the option is checked, the
new timeline will appear for all slides.



The next menu gives you an opportunity to
choose among the options, which are selfexplanatory. You should just select what you
need.

For a example, if you set Stop at the end of this slide for the third slide, the slide show will
be stopped, till you click Right on the keyboard.
If you select Loop this slide, in this case, the slide will get caught in an endless loop. If
there is animation in this slide, it will also be looped, till you press Right. This option is very
useful for creating the menu, from which the slide show will go further.

Background
It`s important to note, that this option is necessary, if the size of the image doesn`t fit the whole
size of the monitor screen and you should fill the left place with some colour or background to be
exact. Here you can choose among Background Colour, Gradient Filling and Tiled
Background Picture.


If you choose Background Colour, just simple colour will appear. To choose the colour, you
should click on the button «A» beside and you will see the following dialogue box.
Using this colour box, you can choose
any colour you wish. You can also
choose between RGB and HSL, which
is the modification of RGB. You can
adjust all necessary parameters.



If you choose Gradient Filling, you will see the next box.
Here you can choose between TopBottom Style and Left-Right Style.
It means that you can add colour
background at the top or at the
bottom of the screen or on the left or
right side of it. To select the colour,
you should also click on the buttons
«A».



If you choose Tiled Background Picture the following box will be shown.
As you can see, by clicking on the
folder, you can select the image
from any directory file you wish and
adjust its size.

Advanced Options
Advanced Options include the button Run External Application. On choosing this option you
can add to your slide show any application from any directory file. It may be any picture, menu,
slide show and so on.

Effect Tab
If you want to add some settings for the slide or to use transition effects, you should have a look at
this tab. Here you can choose among a great
number of different transitions by clicking on them.
You can select Fade in/out, Hour hand, Circle,
Rhombus, Rectangle, Gates, Page Effect,
Advanced hour hand, Mosaic, Push Effect,
Slide Effect, Curling of Page. To see how these
transitions work, just click on them and have a
look.
You can also adjust the thickness of smoothing
line and Effect duration, that is the time of
continuance of this effect, by using up and down
arrows for setting the time.

Music Tab
If you want to add music to the slide, you should use Music Tab.
Note, that this sound file you choose, will be
added only to an individual slide. If you want to
add music to the whole slide show, you should
use Project Options, Music Tab, where you
adjust not a single slide, but all the slides in the
slide show.
You should remember, that if you add music file
in this way, the music will be stopped after the
slide is shown.
Here you can also Add several music files,
choose among them, Remove them and Clear
the playlist.

Objects and Animation
Main Window
In addition to the customized settings of the slide, you can adjust some other options, such as
Objects and Animation.

When clicking on the button Objects and Animation in the preview window, the main window,
which is shown above, will appear. Here you can see the information bar in blue colour, where
you see the name of the file, which you have selected. Under the information bar there is the tool
bar, which includes a number of icons.

With the help of the first icon Frame you can add frames to the slide. If you add the frame, an
image or a group of images will be dependent on it. It means, that a frame will be a parent
and all images inside it will be its children. You can adjust a lot of options: colour, opacity,
drop shadow, pan/zoom, size of the frame and so on.
The next icon Add Button helps you to add buttons to your slide. With the help of it you can
make different actions to the slide and to the slide show on the whole. For example, you can
exit the slide show, go to the next or previous slide, make a pause, send e-mail. The whole
list of all possible functions you can find in the common tab on the right side of the main
window. As well as with the Frame, you can customize the view of the button according to
the colour, size, shadow. You can also add the necessary text of any font, colour and size.
The icon in the form of «A» helps you to add the text to the image. You can choose font,
size, also shadow, pan/zoom and other options here to make your comment fit the style of
the image and the slide show.

The fourth icon Rectangle as well as frame may be used for making slide shows more
animated. It may be also used as backgrounds to the images.
On clicking the fifth icon Add Image the dialog box, where you can choose the necessary
image from the directory tree of files, will appear. If you want your added image to be
independent from the other objects, you should see, that no objects are highlighted in the
object list in the right lower corner of the main window, before clicking on this icon.


The next button Delete is used, when you want to delete the selected object from the object
list. You should remember, that if you delete a parent object, all its children objects will also
be deleted.



The icon Undo and the > icon, that means Redo, give you an opportunity to make changes
during your work till they are not saved.



The ninth and tenth icons Copy and Paste are used to save images and other effects and to
use them later with other slides. It`s very convenient, if you want to use similar effects and
transitions with several objects. You just should highlight the necessary effects in the object
list and click the button Copy, then open the next slide and press Paste. All effects will be
applied to that image.



The next icon shows the scale of the slide. You may choose the necessary number of
percents from 10% to 500% for better view of the image. It`s convenient, when you want to
have a look at the image, but the size of it is very large or small. If it`s large, you may reduce
the Percentage View up to 10% if you can`t see the whole image at 100%. On the other
way, if the image is too small, you can put 100% and more for better look at it.



The last icon Close allows you to close the main window of this option Objects and
Animation.

Properties Tab
The Properties Tab is situated on the right side of the main window of the option Objects and
Animation and shows the main characteristics of the image or object. Here you can see the
information where this image or object is located on your computer.
You can also choose if the slide is the main image in the object list, if the edge antialiasing and if
there is blurring.


The Edge antialiasing should be normally turned on. It is
used to minimize the distortion of some artifacts of high
resolution images, when they are shown at low resolution.



Blur feature is very convenient if you want to minimize the
pulsing of the image, which you zoom.



Low quality of resizing is the feature, which shouldn`t be
always used. It`s helpful only when the quality of the image
is not very good and you have white lines in your image.

For better understanding of the functioning of this option it is better to see the difference. Both
images are zoomed out.

The first variant is made without the option Low
quality of resizing, the effect is degraded.

The second variant is made with the help of Low
quality of resizing and the picture seemed to be
more legable and sharp.

Common Tab
The Common Tab is found next to the Properties Tab and includes the following options:


First you can see the Name of the image you have selected
and adjust.



Then you can choose the Action on mouse click: None,
Exit, Next Slide, Previous Slide, Help and so on.



You can customize Drop shadow (the figure is shown below).
Here you can select the Colour of the shadow by clicking in
the colour box. You may set Opacity from 0% to 100%,
Angle and Size of the shadow, Distance from the image and
Spread (Form) of the shadow. At last you can save shadow
as the Templates.



Perspective Correction of Zoom is used instead
of camera zoom.



Transparent to Selection gives you an
opportunity to make changes of the selected
object without touching the other objects, if there
are any.



Time Range – here you can set the time of
showing the image in the slide show. But you`d
better use timeline window.



You can also select the Mode among Original, Fit to slide, Cover Slide. Original is the real
full size of the slide and it`s not very convenient to use. It`s better to use Fit to slide mode or
Cover slide mode while customizing the image.



You may also fit the position in pixels or in percents.

Animation Tab
Animation Tab contains such options as Pan, Zoom, Rotate, Opacity and some others, which
will be described further:


Pan effect has horizontal and vertical positions, with the help
of which you can move the image left/right and up/down. As
you can see from the figure, you may customize it with the
help of up/down arrows. The left block links with the left and
right movements of the image and the right block links with the
up and down movements. You may also move the slide by
dragging it with the help of the mouse. In this case, the display
in these two blocks will be changed automatically.

Zoom effect helps you to enlarge or diminish the image, it
depends on your choice. You may do it with the help of
up/down arrows or by dragging the green rectangle of the
image with the mouse. There is one special feature in this
option. You can see a small square between the boxes with
arrows, by default it is turned off, and the slide changes its
size proportionally, that is the figures in both these boxes are
the same and the slide just changes its size without changing
its form. But if you turn this small square on by clicking on it
with the mouse, it gives you an opportunity to change not only
the size of the picture, but also the form of it. It means that you
can compress or extend the image. With the help of the
arrows in the left box you may change the image horizontally and in the right box vertically.
If you change the image and then you want to make it proportional, you can just turn this small
square off and the slide will become proportional again.




Rotate effect gives you an opportunity to rotate the image clockwise and counterclockwise.
The default setting is zero here. If you click on the arrow in the rotate box, the following dialog
box will be opened.
Here by moving the cursor in this box, you may rotate the image in
both directions. It`s important to note, that you may also move the slide
dragging it by the angle of the green rectangle, which you may see if
the object is highlighted.



Center effect is a very powerful feature, which gives you a lot of opportunities in animating
and customizing the images. It`s important to mention, that the center of any image or object,
which you want to adjust is situated in the real center of it. If the image is highlighted, you may
see this center, which is shown by the green circle in the green rectangle. If you want to
change it for some reason, you may do it with the help of this option. You should press Shift
and drag the center with the help of the mouse simultaneously in the direction you wish. That
will be your center of the image from that moment. You may now move the image and the
center will be on its new place. In the boxes with up/down arrows you may change the
figures and the image will move relatively its center horizontally and vertically. If you use the
arrows in the left box, up arrow helps you to drag the image to the left, down arrow to the right.
If you use arrows in the right box, up arrow moves the image up, down arrow moves it down.
This option is also very helpful not only in moving but also in rotating the slide. To have a look
at all possibilities of this option, it is better to experiment with it.



Opacity effect also helps you to make a lot of different things and views. Opacity varies from
0% to 100% that means you can make the image invisible at all or vice versa visible. The
default setting is always 100%, but you may change it by dragging the cursor in the opacity
box. You may add several objects or images and set different opacity for all of them. The
effect is very beautiful. For better understanding of this option it is better to try to work with it.



Keyframe Time option shows the time of the current slide from one keypoint to another one
and will be described further (see Timeline Operation p. 51).

Linearity
In several options such as Pan, Zoom and Rotate you may find Linear movements of the image,
which you may adjust. When clicking on it, the following dialog box will appear.
Here you can see Settings up, Linear and non-linear features:
Accelerate, Slow Down and Smooth.


Linear means that an object or an image moves (begins, continues
and ends) with one and the same speed.



Accelerate begins slowly and then accelerates up to the end.



Slow Down begins at a high speed and then decelerates up to the
end.



Smooth begins slowly and ends also slowly, but in the middle it
moves with linear speed.

More often Linear and Smooth movements are used.
First you should choose linear or non-linear movement, then click Setting up and the next box will
be opened.
Here you can see the number of
keypoints, which you have created for a
certain image in the timeline window.
You always have the first and the last
keypoint and a number of inner
keypoints. The first and the last cannot
be changed, but inner keypoints are
changeable. You can see the scissors on
the inner keypoints, which may help you
to seperate the movement or vice versa
to glue it. The difference is, that if you
separate, the movement will not be
smooth. So it is better not to do it and to
leave it as it is. So if you make some
changes here, you should make them
also in Pan, Zoom and Rotate options.
It`s important to note, that you may save
these speed options as Templates and
use with other images.

Object List
Object List is situated in the right lower corner of the main window of Object and Animation.
Here you can see the list of images and objects, which you have added and work with.
You can add objects to the object list in several ways:


by selecting the buttons in the tool bar above the preview window: Add
Frame, Add Button, Add Text and so on;



by right clicking on the preview window or the object list, where pop-up
menu will appear and you may choose the necessary object: Image,
Rectangle, Text or Hyperlink, Button or Frame.

It`s important to note, that there are parents/children relations between objects. As you can see
from the figure above, there are two main or parent objects and several children objects for each
main image. It means, that children objects are subordinated to the parent ones and they have all
features of their parents. If you delete a parent object, all children objects will be also deleted.
With the help of the object list, you cannot only add or delete different objects, but also adjust
them. When right clicking on the object list, you may perform different operations.
As have been said already, you may Add, Delete, Cut, Copy and Paste
objects. You may also change the order of the objects.

Besides, you may also use keyboards shortcuts for quicker work at your
objects. For better understanding of this options, it is better to experiment
with them.

Timeline Animation
Timeline option is situated below the preview window and contains a number of features.

Here you can see the blue rectangle, which identifies the time of showing a current slide. The blue
line on the left shows the beginning of the slide and on the right - the end of the slide. You can also
see keypoints, which are highlighted in pink. Above the first keypoint there are the figures in blue,
which show the time from the first image up to the current slide. You can add any number of
keypoints to your slide by clicking the button «+» or delete them with the help of the «-» and make
different positions of the slide on the screen. That is one of the uses of timeline option, you can
make various animations with one or more slides. You may also drag these keypoints by left
clicking of the mouse and putting them to the necessary position on the timeline bar. In this case,

the figures above the keypoints will change according to their position.
On the right from the blue rectangle you may also see two buttons with left and right arrows. They
are used to highlight the keypoints and move the blue triangle cursor on the grey bar. You can also
use the mouse for this purpose, but if you have a great number of keypoints, which are near one
another, it is not very convenient to control them manually and it is better to use these two buttons.
Below these buttons you can see one more option Play. With the help of it you can preview the
animation of the current image, but without music background. It is just a quick way to check the
animation and to change it then, if it is necessary. It`s important to note, that if you want to have a
look at the whole slide show with music and all effects and transitions, you should use option
Preview. If you want to see the slide show from the current slide, you should use the button nearby
the Preview button.
Below the blue rectangle, where the timing of the slide is shown, you can see the same buttons as
in the Main Window. They are Create, Preview, Project Options and Customize Slide, which
have already been described (see The Control Buttons p. 22).
Beside Customize Slide there is one more option, which have not been described yet, Tools.
When clicking on it, the following dialog box will be
opened.
With the help of this menu you can Undo and Redo some
changes and if you don`t like your work at all, you can
Undo or Redo All Changes at once.
Besides, you can select such options as Show safe TV
zone, where you can see the zone, which you will see on
TV; Ignore Objects Not Selected and Hide Selection
on Pan/Zoom/Rotate, which are self-explanatory.

How to create Pan effect
If you want to create Pan effect, you should do the following steps:


You should select the picture and click Object and Animation in the Preview window.



Then you should choose Animation tab in the right upper corner of the main window of the
Object and Animation option.



After that you should set the keypoints on the timeline bar.

First you should set the keypoint, which is shown in pink and then customize the position
and the size of the slide by dragging it with the help of the mouse or using small blue arrows
in the Animation Tab > Pan.
The next step is to set another keypoint by dragging the blue triangle, as seen above, to the
necessary position and pressing the button + for adding the keypoint. When you have added
the next keypoint, adjust the position of the slide. That time from one keypoint to another
one, the slide will move from one position to the other one. See the example.
That is one position of the slide on the first
keypoint.

This is another position of the second
keypoint.

That is how to create panning of the slide, if you want it in your project.

How to create Zoom effect
If you want to create Zoom effect, do the following steps:


You should select the picture and click Object and Animation in the Preview window.



Next you should select Animation Tab in the right upper corner of the main window of the
Object and Animation option.



Then you can zoom (enlarge or diminish) your image with the help of small blue arrows in
the Zoom tab. You can also do it by dragging the angles of the image with the mouse.



You can use timeline bar to make animation here.You should set the keypoints on timeline
and adjust the position and the size of the slide in each keypoint. See the example.
As you can see from the example,
this is the position of the slide in the
middle of its duration. The blue
triangle is in the middle of timeline
beside the second keypoint.

From that example you can see the
zoomed picture in another keypoint
position. The image can be
adjusted with the help of the mouse
by dragging the angle of the green
rectangle
to
the
necessary
direction. You can also do this with
the help of blue arrows in the
Animation Tab.

On clicking the Preview or Play button, you can see how the animation works.

Project Options
Project Options are the main options, with the help of which you can adjust your slide show. They
contain several tabs such as Main, Advanced, Music, Comments, Screen, Effects and
Messages Tab. It`s important, that all these options are for the whole slide show and not for each
slide.

Main Tab
The first tab in the Project Options is the Main Tab.





First in the main settings you should choose
between creating slideshow (EXE file) or
screensaver (SCR file). The default setting
is always EXE file, so if you want SCR file,
then you should change.



If you want to use your own icon for your
slide show, you should press the button
Assign icon (*.ico file) for EXE file of
slideshow and choose the necessary 32x32
or 16x16 icon from your computer.

Next you can make startup window show, if you want it in your slide show. You can
customize it by clicking on the same button. In this case the following dialog box will appear.
In the Startup window you can set the image, if you
want, by selecting it from your computer. You can also
add some comments and information about the
author of this slide show, if you want. You can mark the
boxes of showing Help and Exit, if you need such
buttons in your Startup Window.



In the next block Show Settings you can select the action after the slide show is over and
adjust some other characteristics. You can Synchronize music and slides, but it is better to
do that with the help of timeline option, which will be described further.



You may also Display slides in random order. In this case, the order, which you have in the
slide list, won`t be observed.



You can also select Time interval for new slides, you may set the necessary number of
seconds. It is better to Set this time for existing slides. In this case, all slides in the slide
show will be shown with one and the same period of time.

Advanced Tab
Here the following options are represented.





In Advanced Options section you may
choose the action on the left/right mouse
click. You may choose among seven
functions such as Exit, Next Slide, Previous
Slide, Help, First Slide, Pause and no
function or None. If you want, you may also
Disable mouse wheel.



You may choose to show mouse cursor or
hide it at startup by clicking on the box. You
may also set the time in seconds, after which
the mouse cursor will be hidden. It is
important to note, that if you move the
mouse, the mouse cursor will appear again
and then will be hidden after the number of
seconds, which you have set up.



The next Permit control of show using
keyboard gives you an opportunity to control
the slide show with the help of keyboard
buttons. For example, you may use PageUp
and PageDown buttons for going to the next
and previous slide. There is a number of
shortcuts, which you may use. It is
convenient to use them for quicker work, if
you know all or several of them.

The next button Show Navigation Bar is used, if you want to see it in your slide show. You
may also Customize Navigation Bar by clicking on the button. In this case, the following
dialog box will be opened.
You can see two small windows
Available
and
Selected
Buttons, where there are seven
buttons, which you can select
for you Navigation bar: First
Slide, Previous Slide, Next
Slide, Pause, Print, Help and
Exit. It is very easy to choose
them and their order by clicking
on them and dragging to the
necessary window or using the
buttons Add and Remove
below these windows.
You may also select the
position and the offset of
Navigation
bar in the
slide show.

If you want, you may Hide Navigation bar in a number of seconds, which you can also
adjust with the help of arrows beside the button. You may also click to Hide Navigation bar
at startup.
You may also choose the style of Navigation bar between Air and Sky Styles. If you want
you may also open other styles in your computer or create them and then open with the help
of the button Styles, which you can find on the right of this dialog box. Besides, you can
show background. To make it, you should click the necessary box with these words.
You can also set Scale and Hue of Navigation Bar by clicking on the necessary buttons
and choosing the size and the colour. The result of your adjustment you can see below in
the preview box.


Run application after last slide is the option, which gives you an opportunity to run any
video, picture or object after the end of the slide show. You may add anything you want from
your computer by clicking on the folder icon beside the button.



In the Protection of Presentation options you can make some settings to protect your slide
show. They are Password, Enabling time limited usage, not allowing to copy pictures
with Printscreen button. You may also show logo of your company and customize its
position, size and opacity, if you wish. While customizing Trial Usage Details (usage of the
slideshow), you may set the last date of its usage, the number of runs and even write the
message for other users, why the slide show doesn`t work any longer.

Music Tab in Project Options
With the help of Music Tab you can add music to the whole slide show.
To add music you should click on the button Add
Music, the dialog box will appear, where you can
choose the necessary music files from your
computer. It is important, that you can add
several files to your slide show. Beside there are
two buttons Remove and Clear. Remove helps
you to delete one highlighted file from the list.
Clear helps you to delete all files from the list.
You can have a look at music duration of all files
by clicking on the button Show Music Duration,
which is found below the list of music files.
You have an opportunity in this program to Play
songs in random order, if you wish, and to
Repeat music after playing. For this you should
highlight boxes with these settings.
If you add sound comments to your slide show,
you can adjust such parameters as Don`t
interrupt sound comment when next slide
appears. If this option is not checked, the sound
comment for the current slide will be played till
the slide is on the screen. When the next slide
appears on the screen, the sound comment is
interrupted. If this option is checked, the sound
comment will be played up to the end.

Comments Tab
In the Comments Tab you have an opportunity to add some comments to the slide show and
customize it according to your wish.




In the first part of the tab, which is called
Customize comment font, you can select
the font of your comments, Bald, Italic or
Underscore font, Colour, Line Spacing,
Offset and the Size of the text. On the right
to the font adjustments you can select the
Position of the comments on a slide by
clicking on the arrow, where drop-down
menu will be opened. You may set from the
variety of choices: on the Left or on the
Right, at the Top or at
the Bottom and so on.
You may either add Drop
shadow, if you check it
and
Customize
its
Colour, Opacity, Angle,
Size and Spread, if it is
necessary. You shouldn`t
forget to Set for existing
files all your settings.

In the second part of the Comments Tab Set text comments for new slides you may either
use comments templates or add new ones according to your choice. If you click on the button
Insert template, the drop menu will be opened. Here you can choose, what you want, and the
necessary information will be added automatically.

Screen Tab
Screen Tab is divided into three sections: Screen Options, Background and Additional
Options. In the first section you may adjust the images to the screen.


First you may choose the Fullscreen mode
or Windowed mode. The default is always
Fullscreen. Here you can also set Aspect
ratio of a slide according to your monitor
size and form. For normal monitors and not
wide television screens the aspect ratio is
4:3 PC/DVD. If you want to set another ratio,
click on the arrow and the drop-down menu
will be opened.
You may choose any ratio
from the existing ones, but if
you
need
something
different, you may click on
Custom
and
set
the
necessary figures manually
(See Aspect Ratio p. 43).
The next option Caption of show works only
for the Windowed Mode. If you have chosen
Fullscreen mode, then this option is of no
use to you.
Hardware acceleration option should be
generally checked, if you create the show
with animations. It gives you an opportunity
to watch your slide show with better quality.



In the Background Section you may set the background as Solid color, Gradient filling or
Tiled image. You should remember, that if your images fill the whole screen, then this option
is of no use to you. But if the images don`t fill the screen, you may select among three
variants, which have been already described earlier (See Customize Slide, Background p.
24).



In the third section Additional Options first you may see Display shadow behind slide
image. If this option is checked on, you can also Customize it.
It is important, that this fuction also works
only, when the image doesn`t fill the
screen. Don`t forget to click on the Set for
existing slides button to set this option for
the whole slide show. When you click on
the Customize button, the following dialog
box
will
appear.

Here you may select the necessary Colour of the shadow,
Opacity, Angle, Distance from the Image and Size of the Shadow.

The Percentage of the slide to show main images is the option, which gives you an opportunity
to watch your slide show at any size on the monitor you wish. It is better to experiment with this
option to see the difference.
The last option Disable scaling of main images (Not recommended) should be normally
unchecked. The reason is that while playing this show on the other computers and this option is
checked, the slides may be shown with different resolutions and the images may be larger or
smaller. To avoid this, it is better not to use this option. Of course, if you want your slide show run
at your own resolution, you can check disable scaling.
Aspect Ratio
This article will help you to prepare your slide-shows for burning on DVD by using PicturesToExe
and Video Builder. Let's try to explain what the difference between DVD aspect ratio and slideshow aspect ratio is. DVD aspect ratio sets by Video Builder in Project Options window. Slideshow aspect ratio sets by PicturesToExe in Project Options -> Screen tab.
Encoding DVD aspect ratio 4:3 - Slide-show aspect ratio 16:9
Here is the example of what happens with slide shows if you'll encode presentation with 16:9
(800x450) aspect ratio (slide-show aspect ratio) with 4:3 aspect ratio (DVD aspect ratio).

1. Slide-show aspect ratio 16:9.
2. DVD aspect ratio 4:3.

4:3 TV display example
While viewing this DVD on TV set with 4:3 sides, video will look like encoded before (picture
below).
1. Slide-show aspect ratio 16:9.
2. DVD aspect ratio 4:3.
3. TV display aspect ratio 4:3

16:9 TV display example
While viewing this video on widescreen TV display, video will look like with 4:3 aspect ratio. This
means, that TV display will add black areas on the left and on the right sides of the video to make
aspect ratio as 16:9. Look at the picture below.
1. Slide-show
16:9.

aspect

ratio

2. DVD aspect ratio 4:3.
3. TV display aspect ratio
16:9.

Encoding Slide-show aspect ratio 4:3
Here is the example of slide show with aspect ratio 4:3. Encoding result of it (DVD aspect ratio 4:3)
will look original without any black areas.

Encoding result
same.

will look

the

1. Slide show aspect ratio 4:3.
2. DVD aspect ratio 4:3.
3. TV display aspect ratio 4:3.

This is the example how such DVD will look with 16:9 aspect ratio display.

1. Slide show aspect ratio 4:3.
2. DVD aspect ratio 4:3.
3. TV display aspect ratio 16:9.

Encoding DVD aspect ratio 16:9 - Slide-show aspect ratio 4:3
For example your slide-show has 800:600 pixels dimension (4:3).

Source slide-show (4:3 aspect
ratio).

1. Slide-show aspect ratio 4:3.
2. DVD aspect ratio 16:9.

16:9 TV display example
As you can see 16:9 TV display shows this video as it looks after encoding.

1. Slide-show
4:3.

aspect

ratio

2. DVD aspect ratio 16:9.
3. TV display aspect ratio
16:9.

4:3 TV display example
As soon as we try to see this video on the TV display with 4:3 sides we can find black areas at the
top and at the bottom of our DVD. These areas are added by TV display to make video aspect ratio
4:3.

1. Slide-show aspect ratio 4:3.
2. DVD aspect ratio 16:9.
3. TV display aspect ratio 4:3.

Encoding Slide-show aspect ratio 16:9
Here is the example of source slide-show with aspect ratio 16:9. Encoding result (DVD aspect ratio
16:9) will look original without any black areas.

Source slide-show (16:9 aspect ratio).
Encoding result will look the same.

This is the example how such DVD will look with 16:9 aspect ratio display.

1. Slide show aspect ratio
16:9.
2. DVD aspect ratio 16:9.
3. TV display aspect ratio
16:9.

This is the example how such DVD will look with 4:3 aspect ratio display.

1. Slide show aspect ratio 16:9.
2. DVD aspect ratio 16:9.
3. TV display aspect ratio 4:3.

How auto aspect ratio mode works in VideoBuilder
This issue is about how Video Builder auto aspect ratio mode works.
Each of the videos being located on DVD disc may have one of the following aspect ratio 4:3 or
16:9. VideoBuilder can't burn DVD with slide-shows using different aspect ratio. If you set aspect
ratio 4:3 (VideoBuilder options) in options all presentations will be in 4:3, if you set 16:9
(VideoBuilder options) all of them will be 16:9.
Even if one of all presentations has aspect ratio, which differs from 16:9 (slide-show aspect ratio),
all of them will be with 4:3 aspect ratio. Only in case, when all slide-shows have 16:9 aspect ratio,
all slide-shows will be in 16:9. Therefore if you create DVD disc for wide width display there is the
reason to set 16:9 aspect ratio for all slide-shows.
Custom aspect ratio slide-show
In case if slide-show has aspect ratio, which differs from 4:3 and 16:9 (for example 5:4) it will fit to
the nearest aspect ratio (see the picture below).

Photos resolution and slide-show aspect ratio
This is the fact, that there is no relation between photo dimension and slide-show aspect ratio. As a
default, the value for slide-show aspect ratio is 4:3 (for new project) and in case, if you add some
photos with 16:9 aspect ratio, the slide-show will not change the aspect ratio automatically. To
change slide-show aspect ratio go to the Project options -> Screen tab and set it manually
according to the dimension of your photos.

Effects Tab
With the help of Effects Tab you can add different transitions between slides and to make your
show animated.
When checking the box Enable transition
effects, all transition effects become highlighted
and you may choose among them. It is necessary
to note, that if you want to see how these effects
work, it is better to experiment with them.
The first several effects such as Fade in/out,
Hour Hand, Rhombus, Rectangle, Gates, Page
Effect, Push and Slide Effects and some others
are self-explanatory. Circle effect has one
peculiarity: you may change the Center here with
the help of small arrows, which are found beside.
If you scroll the Effects Tab down, you will see
such effects as Mosaic, Curling of Page, which
should be described.
Mosaic has different appearances and can
consist of different number of pieces, which can
move with different speed.

You can set any number of pieces. If you want
large pieces, you should set less number of them
and vice versa, if you want small ones, you
should select more pieces. It depends only on your choice, try to experiment.
Curling of Page can also be different according to the radius, which you choose. To see the
difference, have a look at the examples below.

As you see, in the first picture the radius is large and on the second one it is small. If the radius is
large, the line is more soothing, if it is small, the line is sharper. Besides, you may also set the
colour of the back side as seen from the examples.
As seen in the Effects Tab, you may also set the Thickness of smoothing line and Effect
duration, which is given in milliseconds, by clicking on the small arrows beside the options.

In the first picture the default setting of thickness of smoothing line is 6 %. In the second is 52%.

Messages Tab
In Messages Tab you can add messages to any parts of your slide show.
There are several section here: Captions on
Buttons, Help Window, Startup window,
Password query. If you scroll down, you will also
see such sections as Expired Trial and Print
Dialog. All sections are self-explanatory and give
you the necessary information. But it is important
to explain some sections.
In Password query you can add the image,
which tells the user of your slide show to enter the
password.
In Expired Trial you can add message, why the
show cannot be run any longer and give some
instructions what to do further.
The messages are added already by default here.
But if you wish you can rename them by adding
your own information. If there is not enough
space, it does not matter much, you may continue
typing.

Timeline Operation
If you want to add background music to your slide show, then customize it and synchronize the
slide show to music, you should use Timeline Option, which is found in the Main Window of
PicturesToExe in the Control Buttons panel.
The main function of the Timeline Option is to synchronize a number of slides to music. There are
several ways to do that:


to auto spread slides along music at equal intervals of time;



to coincide slides with the certain points in the sound track;



to coincide slides with the certain points in the sound track not only with music but also with
some commentary.

Some timeline options are represented in the main window menu View. If you click on it, the
following dialog box will be opened.
Here you can select the Style of Auto Scroll between Style 1
and Style 2 or Don`t Use Auto-Scrolling at all. The difference
between two styles is in the presentation of the synchronization
while watching it on the timeline bar.
You can also make Zoom of the timeline window In or Out by
clicking on these buttons or using shortcuts, which you can see
opposite the words.
You may also choose the Colour of the Waveform. By clicking
on it, the dialog box will be opened, where you can choose the
necessary colour. Besides, you can select Display Waveform in two ways.
While adjusting your slide show in the Project Options, tick the synchronization of music to the
slides in the Main Tab. If you make this, then in the Customize Synchronization window, the
default is Synchronize music and slides. Besides this, you may tick Auto spread slides along
music. In this case, the timeline window will be greyed out and the slides will be equally distributed
along the whole music track. For example, if you have sound track, which lasts 1 minute, and you
have 10 slides in your slide show, then the intervals between the slides will be 6 seconds.
To see the timeline and synchronization window, you should click the button Timeline, and the
following window instead the Slide List will be opened.The timeline window is represented below.

Here you can see slides, which are represented by figures below the line. The figures above the
line indicate the seconds.The beginning of the timeline is zero, the end depends on the duration of
the sound track and may be any number of seconds or minutes. Thick grey lines beside each
slide indicate transition time. You can also see a blue triangle, with the help of which you can go
from one slide to the other one. It is important to note, that you can change the position of the
slides by clicking on a number of the slide and dragging it to the necessary place. Besides this, you
can also change the time of transition by clicking on the end of the grey line and dragging it to the
right or to the left, it depends on whether you want to make transition longer or shorter.

Now it is necessary to describe the buttons, which are situated above and below the timeline
window.



Play button is situated above the options Customize slide and Objects and Animation in
the Preview window and is used to begin the preview of your slideshow in a small preview
window in the right upper corner. This button plays two roles: Play and Pause. If you click on
Play it will turn
Pause and vice versa. When you click on Play, the blue triangle will stand
at the beginning of the timeline and will move to the right on the bar.



As you can see from the figure above, next to the button Play/Pause there is button Stop.
You should remember, that if you click on Stop and then on Play button, the preview will start
not from the beginning, but from the place where the cursor was situated. If you want to watch
the preview from the beginning, you should do the following:
Click Play for previewing the slide show;
As soon as Playback begins, click Pause;
Drag the blue triangle to the beginning and click Play once again.



New transition is the option, which gives you an opportunity to add new keypoints to the
necessary place of your slide show and timeline. It is important to know, that for adding the
keypoint you should set the blue rectangle to the necessary place on the timeline bar and then
click on the button New transition. The slides and their transitions will be moved from their old
places to new ones.



If you want to delete the keypoints you should use the option Cut transition. But you should
remember, that the keypoints will not be deleted, but just moved to the end of the slide show.
If you press the button New transition in this case, the keypoints, which were deleted earlier,
will be moved to their previous places.



Next option Timed Points includes the following functions:
Arrange All Points helps you to set all points
on the timeline bar in the equal intervals of
time along the sound track.
Arrange Selected Points is greyed out,
because there are no selected keypoints. But
if you select some points, this option will be
highlighted and you can use it. It functions in
such a way: you should select the necessary keypoints and then click Arrange Selected
Points, in this case, all selected points will be set at equal intervals of time. Of course, you
can do this manually, but it is much easier to set them automatically.

Shift Points is the option, which gives you an opportunity to move all or selected points to the
necessary direction, to the right or to the left on the necessary number of seconds. For doing
this you should select the keypoints and click Shift Points. In this case the following dialog
box will be opened:
Here you can Choose Direction,
where to shift the points, the first arrow
gives you an opportunity to shift to the
left, the second one – to the right.
Then you can set a number of seconds
and milliseconds, on which you wish
to shift the points.
After that, click OK and see the result.
Set Time of Points is the option, which gives you an opportunity to set all the slides or just
selected slides at the intervals, time of which you can set manually. To do this, you should
select the slides, if you need, and click button Set Time of Points. In this case, the following
dialog box will be opened:

Here you can set a number of milliseconds, which the
slide will be shown in the slide show.

Import Points from Another Project is the option, which can be very helpful, if you don`t
want to make a new timeline. You may just import points. To do this, you should click this
button and then choose the project, from which you want to import the keypoints. It is
important to know, that the number of slides in these two projects should be equal.


Next to Timed Points you can see a small box with numbers, which show the time of
the chosen slide in the timeline bar.



The first buttons below the timeline bar is Create, Preview, Video, Project Options were
explained earlier.



Options Add, Remove Slide, Clear List are related not only to the Slide List, but also to the
Timeline. It depends on what you are adjusting. With the help of these options you can Add
slides to the timeline, Remove one or more slides and Clear List. In the last case, all the
slides will be deleted from the timeline and you can set a new timeline, if you wish.



Next to these three options you can see the button, which is called Waveform. Clicking on it,
you will see the waveform of the sound track on the timeline bar. It is important to
know, that the waveform will appear only if the soundtrack is added.



It is necessary to note, that you can adjust the color of the waveform in the View Menu >
Timeline Options. Besides, you can select the Display of the waveform in two ways.
The difference is only in the way of presentation the waveform. In the
example above you can see the waveform with Mixed channels.
Below you can see the example with Left and Right channels.

After having adjusted all these options, you can see the result either by clicking button Play (in this
case, you may see the slide show in a small preview window) or by clicking button Preview (in this
case you may see the slide show fullscreen).

Video Options
If you have a look at the Control Buttons, you will see Video button. When clicking on this button,
you will see the window, where you can select between DVD-Video or AVI file.

Video Builder (DVD video disc)
If you choose to create DVD-Video in Video button, another program, which is called Video
Builder, will be opened.

At the upper left corner of the main window there are three main menu: File Menu, Edit Menu,
Help Menu.

File Menu
When clicking on the File Menu, the following drop menu will be opened.
Here you can make a New file, Open other files, Save and Save As
your work, Burn ISO image. When clicking on the Burn ISO image,
the following window will appear.
The Burning Options are
Device, with the help of
which you will burn, Speed,
chosen by you, Label and
the last, you should choose
the place for ISO image on
your computer. Then click Burn ISO or Cancel, if you
don`t want to do anything here.
It is important to note, that ISO image is a special file,
which is used to run the project, which you burn on the
disc, without this disc.

Edit Menu
With the help of this menu you can make some operations with the projects.
You can Add or Remove projects, Clear the project list at all, Move to
the Left or to the Right from one project to the other. You can also see
File Info. If you click on the File Info, the following window will be
opened.
Here you can see the information
about the chosen project: File
Name, the place, where it is
situated on your computer, the
Duration of the sound track, the
Size, the Date of creating and
Aspect Ratio, how it would be seen from the monitor. In
personalized settings you can choose Video Type, the
default is Auto always, and you can also choose whether
to check Anti-Flicker filter or not.

Help menu gives you hyperlinks to the official PTE site, where you can find any information about
this programs and ask questions, if you have any.

Below the main menu there is the drive selector, where you can choose the necessary drive.

As seen from the figure above, drive X is chosen.
Below the drive selector, you can see the file directory tree of the chosen drive. Nearby there is
the preview window for a selected file or project. Below the preview window you can see the
same buttons as in the Edit Menu: Add, Remove and Clear. Then the project list is situated,
where the chosen projects can be seen and their duration and size are shown below in a special
box, shown below. Red vertical line indicates the end of free space on the disc.

On the left from this box there are several options, which should be described. The main of them is
Project Options.


In the Project Tab of the Options there are
several sections. In Video options first you
should choose TV system according to the
country you live in. There are two systems:
PAL/SECAM is used in the Europe and
NTSC is used in the North America, Japan
and some other countries.



Next you can choose Menu and Title
aspect ratio. The default for Menu aspect
ratio is 4:3 for ordinary televisions, but you
may also select 16:9 if you have new
televisions such as LCD or flat panel TV
screens. The Aspect ratio for them differs
from the old ones. The default of Title
aspect ratio is Auto, but you may also
select 4:3 or 16:9. You should remember,
that it is the aspect ratio not for your
slideshow, but only for the menu and title.



Next you can choose Bitrate, the default is
7000 kbps, but if you have the necessity,
you can change this figure.

The next Video Type can be also changed.
There are two types of them: Interlaced and
Progressive. The default is Auto, that is
Interlaced. But if you have a new TV, such
as LCD or flat panel televisions, you`d better select Progressive video type.




In Audio options you may select the necessary Audio format and its Bitrate. Here it is better
to use default settings to avoid a bad quality of sound track.



In Advanced Options you can customize such settings as to Repeat playback of a disc or
not, to Return to menu after each title or not. You can also add chapters to your DVD-disc
and set the number of minutes for each chapter.



In the Program Tab you can choose the place for the temporary file of your project.



The next buttons are Set Defaults, OK and Cancel, which are self-explanatory.

Nearby the Project Options button you can see several options.

You can check Create menu box, if you want the menu on your DVD-disc. Next you can choose
the size of your DVD, the default is 4.7, but if your disc is larger or smaller, you can choose two
other parameters 8.5 and 1.4. Next you can see the bar, which shows the total space on the disc,
as has been said above. Here you can see the blue colour, which indicates the space occupied,
and the white colour, which indicates the free space. The red line shows the end of the free
space on your disc. At the end of the bar, there are two buttons Back, which is greyed out, and
Next, which are also self-explanatory. Next gives you an opportunity to go forward and Back backwards.

When you have selected the projects, which you want to burn, it is necessary to click Next button
and the following window, which is shown above, will be opened. Here you can customize the
menu for your DVD-disc, if you want it. You should remember, that if you don`t check the box
Create menu in the previous window, this window won`t be opened and just the next one will be
opened at once.
It is important to note, that the word Title can be changed by clicking on it and typing the
necessary words.



First you should choose the background for your menu. There are several templates, to have
a look at it, you should click on the picture and you will see the following window.
Here you can see the templates and
choose among them. At the bottom
of the window you can see two
buttons Add template and Organize
templates. The first one gives you
an opportunity to add any image or
photo from your computer. The
second one helps you to choose the
order of the templates and rename or
delete the images. For better
understanding have a look at the
figure below.



Next you may choose the number of items and their
location on the menu window.
The more items you
want to add, the less
size they are. The
location of them also
depends on the number
of the projects you have
added. It is better to
experiment for better

understanding of the difference.


Then you can customize Hue, Saturation and Lightness. When clicking on these words, the
following window will be opened.
The default position is represented here, but you
may adjust everything according to your wish by
moving the cursors to the right or to the left.



You can also see two options Properties and Select Frame, which are greyed out. To
highlight and customize them you should click on the project in the menu window. When
clicking on the Properties, the next window will appear, where there are two tabs: Property
and Drop Shadow Tabs.

In the Property tab you may set the position and the size of the project window by clicking on the
small blue arrows. You can also customize Opacity, if you wish.
In the Drop Shadow Tab you can add and customize shadow to the project window, if you wish.
You may adjust the colour, opacity and Angle of the shadow, distance from the window, size
and shape of it. You may also add some shadow templates to your wish.
In the Select frame option you can choose the picture, which you want to see in the project in the
menu window.You can scan the project with the help of the Play button and stop at the necessary
image. This image will be represented in the
project window.



After that you can choose background image and customize it. When clicking on the folder
beside this option, the window will appear and you may select the image from your computer.

When clicking on the Customize button, the next window will be opened.
Here you can select the location of the background:
tiled, centered and so on. The examples are given in
the figure beside. You may also choose background
colour, but you should remember, that you will see it
only if the image doesn`t occupy the whole screen.

 Next you can customize Animated Menu and
Menu Duration. The default duration of the menu is 10 seconds but you may set the time
you wish with the help of small blue arrows beside.


The last point here is adding music. If you wish music to your menu, you should check the
box and the option will be highlighted. Clicking on the folder, you may choose the sound track
from your computer and then customize it.

Above the preview window you can see the arrows of different form. The first two mean Previous
and Next Page.
They are greyed out in our example as we have only one project. If you have more than one
project, in this case, you will have more than one page and the suitable buttons will appear on the
menu.
The next two buttons Redo/Undo give you an opportunity to make some changes, if you want to
correct something in your menu.
Nearby Redo/Undo buttons you can see the Scale button, with the help of which you can change
the size of the preview window, if you want to customize it and you need another scale. The
default is Auto. But you may select from 10% to 500% of the screen.
As you can see from the figure below, the preview window is surrounded by dark blue rectangle,
which shows safe TV zone.

In the first picture you can see this rectange, which determines the zone you won`t see on your TV.
In the second picture you can`t see this zone, you just see the whole picture on you monitor. It is

recommended to show TV zone, because it is more convenient to adjust your menu watching this
zone. But if you want to switch this option off for some reason, then you should rightclick on the
menu and the following box will be opened.
This dialog box is the same as Edit menu of this window. So you
have two ways of opening it: by rightclicking on the preview
window and by clicking on the Edit menu in the left upper corner of
the main window.
You can see several options here, almost all of them have been
described already.
Apply changes for each page is the option, which helps you to
make all changes very quickly. If you have more than one project
and more than one page in the menu and you have done some
changes on the first or second page, for a example, you can click
on this option and these changes will be applied for all pages.
When having adjusted this window, press the button Next to go to the next step.
When clicking, the following window for burning the disc will be opened.



First you can enter the name of your project. In our example the project is untitled, but in
your project you can click on this word and enter any name you wish.



If you wish you can create MPEG2 Files, DVD Folders and ISO image of your project. Check
the boxes and just choose the folders for them on your computer.



In Burn DVD disc option the device and the speed of burning is determined automatically. Of
course, if you have several burning devices, you can choose among them.



You may also include any additional folders and files to the disc, if you want. For doing this,
you should check the box and clicking on the folder select the files from your computer.

Having done all this, press the button Start in the right lower corner of the window.

Create AVI video file
If you want to create AVI video file instead of DVD video disc, you should choose this button in the

following box, which will appear, if you click Video button in the Control buttons.

When clicking this button Create AVI file, the following dialog box will be opened.


First you can select what file or
disc to create. If you want to
create AVI video file, first you
should make some adjustments.
But if you want to select among
other variants, you`d better
understand
the
difference
between them.

VCD (also called video CD,
video compact disc or "disc") is a
format specifically designed to
hold MPEG-1 video data and to
include interactive capabilities.
VCD has a resolution similar to
that of VHS, which is far short of
the resolution of DVD format.
Each VCD disc holds 72-74
minutes of video and the bit rate is 1.44 Mbps. VCDs can be played on a VCD player
connected to a television set (in the same way that video cassettes can on a VCR) or
computer, on a CD player, on some CD-ROM drives and some DVD players.
SVCD disc (the Super Video CD) standard upgrades the Video-CD format. It utilizes better
Video and Audio quality. It also standard includes extensions for surround sound multichannel audio, provisions for PC playback. It's also based on variable bit rate (VBR) MPEG2 coding for more efficient use of disc capacity.The bit rate is up to 2.6 Mbps.
DVD-Video disc (Digital Video Disc) is a popular optical disc storage media format. Its
main uses are video and data storage. Most DVDs are of the same dimensions as compact
discs but store more than 6 times as much data. The capacity is from 4.7 Gb on a singlesided single-layer disc up to 8.54 Gb on a single sided double-layer disc.
HD-1080p (High Definition) is the name for a category of display resolutions. The number
"1080" represents 1,080 lines of vertical resolution, while the letter p stands for progressive
scan (meaning the image is not interlaced). 1080p is considered a HDTV video mode. The
term usually assumes a widescreen aspect ratio of 16:9, implying a horizontal resolution of
1920 pixels. This creates a frame resolution of 1920×1080 or 2,073,600 pixels in total. The
frame rate in Hertz can be either implied by the context or specified after the letter p, such as
1080p30, meaning 30 Hz.
HD-1280x720p is another high definition format, the difference with the previous format is in
the number of lines.
It is important to note, that when changing the format, the window will also be changed. It depends
on the number of programs, which support this format. If the program doesn`t support the certain
format, it is greyed out for every certain format.



Next you should choose TV system parameters, if you select one of 5 formats, except AVI
video file. If you live in Canada, the USA, Japan, you should select NTSC. If you live in
Europe, select PAL/SECAM.



The default of Sound Fading is 500 ms., but if you want you may change it.



After that, if you want, you may choose Audio and Video codecs. Codec is a special device,
which is used to compress data, in this case, music (audio) and video. It is important to note,
that the quality of sound and video is not changed, only their size is reduced. When you press
the buttons Audio and Video Codec, you can select the necessary program for compression
manually, but the program always does it automatically.



The next three windows here denote the number of vertical and horizontal lines and the
number of frames per second (FPS). You can also change it manually, but it is better to set
the default settings here.



You may see the preview button here and set the time (the number of seconds), which you
want to preview. The default is 10 seconds here.



At last you should press Create AVI or Cancel, if you don`t want to create anything.



When you press Create AVI button, the dialog box for saving it will be opened and after that,
the following dialog box will be opened.

When creating process is finished, burn this AVI file on the disc.

Hotkeys
F1 – Help
F2 – Rename
F3 – Fullscreen View (File Panel)
F4 – Fullscreen View (Slide List)
F5 – Preview
F7 – Create Screensaver...
F8 – Create Slideshow As...
F9 – Create Slideshow
F10 – Exit
Alt+B – Create Backup in ZIP
Alt+F – Rotate counterclockwise
Alt+I – Ignore Objects Not Selected
Alt+R – Random Order
Alt+S – Replace Main Image
Shift+F1 – Burn DVD-Video Disc...
Shift+F2 – Create AVI file...
Shift+PageUp – Bring to Front
Shift+PageDown – Send to Back
Ctrl+1 – File Panel as Thumbnails
Ctrl+2 – Slide List as Thumbnails
Ctrl+3 – Text or Hyperlink
Ctrl+4 - Button
Ctrl+5 – Frame
Ctrl+F1 – Classic View
Ctrl+F2 – Horizontal View
Ctrl+F3 – Vertical View
Ctrl+F4 – File Name
Ctrl+F5 – File Extension
Ctrl+F6 – File Date
Ctrl+F7 – File Size
Ctrl+F8 – Unsorted File
Ctrl+F9 – Create Slideshow and Run
Ctrl+F11 – Zoom In
Ctrl+F12 – Zoom Out
Ctrl+A – Select All Pictures
Ctrl+B – Objects and Animation
Ctrl+C – Copy Slide

Ctrl+D – Add All Pictures to Slide List
Ctrl+E – Manage Templates
Ctrl+F – Rotate Clockwise
Ctrl+G – Show Tree
Ctrl+H – Shift Timeline Points
Ctrl+L – Timeline
Ctrl+M – Set Comments on All Slides
Ctrl+N – New
Ctrl+O – Open
Ctrl+P – Project Options
Ctrl+R – Start Preview from the Current Slide
Ctrl+S – Save
Ctrl+Shift+S – Save As...
Ctrl+T – Set Time of Points
Ctrl+U – Customize Current Slide
Ctrl+U – File Info
Ctrl+V – Paste Slide
Ctrl+W – Open Picture
Ctrl+X - Cut
Ctrl+Y – Redo
Ctrl+Z – Undo
Ctrl+Home – Move to Top
Ctrl+End – Move to End
Ctrl+PageUp – Forward One
Ctrl+PageDown – Back One
Ins – Add Keypoint Here
Ins – Clone Keypoint
Ins – New Transition
Del - Delete

Glossary of Necessary Terms
«A»
Animation is the rapid display of a sequence of images of 2-D artwork or model positions in order
to create an illusion of movement. It is an optical illusion of motion due to the phenomenon of
persistence of vision, and can be created and demonstrated in a number of ways. The most
common method of presenting animation is as a motion picture or video program, although several
other forms of presenting animation also exist.
Antialiasing is the technique of minimizing the distortion artifacts known as aliasing when
representing a high-resolution signal at a lower resolution. In the image domain, aliasing artifacts
can appear as wavy lines or bands, or moire patterns, or popping, strobing or as unwanted
sparkling; in the sound domain, as rough, dissonant, or spurious tones, or as noise. Anti-aliasing is
used in digital photography, computer graphics, digital audio and many other domains.
Aspect Ratio of a two-dimensional shape is the ratio of its longer dimension to its shorter
dimension. The aspect ratio of an image is its displayed width divided by its displayed height.
Audio Codec is a hardware device or a computer program that compress/decompress digital
audio data according to a given audio file format or streaming audio format. The term codec is a
combination of 'coder-decoder'. The object of a codec algorithm is to represent the high-fidelity
audio signal with minimum number of bits while retaining the quality. This can effectively reduce
the storage space and the bandwidth required for transmission of the stored audio file. Most
codecs are implemented as libraries which interface to one or more multimedia players, such as
XMMS, Winamp or Windows Media Player.
Audio format is a medium for storing sound and music. The term is applied to both the physical
recording media and the recording formats of the audio content – in computer science it is often
limited to the audio file format, but its wider use usually refers to the physical method used to store
the data.
AVI-file (Audio Video Interleave) is a multimedia container format introduced by Microsoft as part
of its Video for Windows technology. AVI files can contain both audio and video data in a standard
container that allows synchronous audio-with-video playback. Like DVDs, AVI files support multiple
streaming audio and video, although these features are seldom used.
«B»
Background or desktop picture, is the image or colour displayed on a website or computer
desktop behind the visible content.
Bitrate is (sometimes written bit rate, data rate) is the number of bits that are conveyed or
processed per unit of time. Bit rate is synonymous with data rate.The bit rate is quantified using the
'bits per second' (bit/s or bps) unit, often in conjunction with a SI prefix such as kilo- (kbit/s or
kbps), mega- (Mbit/s or Mbps), giga- (Gbit/s or Gbps) or tera- (Tbit/s or Tbps).
«C»
CD (Compact Disc) is an optical disc used to store digital data, originally developed for storing
digital audio. The CD, available on the market since late 1982, remains the standard playback
medium for commercial audio recordings to the present day. Standard CDs have a diameter of 120
mm and can hold up to 80 minutes of audio. There are also 80 mm discs, sometimes used for CD
singles, which can store up to 24 minutes of audio.
Comment in PicturesToExe is the text, which appears during the showing of images.
«D»
Duration is an amount of time or a particular time interval.
DVD video disc (Digital Video Disc) is a popular optical disc storage media format. Its main
uses are video and data storage. Most DVDs are of the same dimensions as compact discs but
store more than 6 times as much data. The capacity is from 4.7 Gb on a single-sided single-layer
disc up to 8.54 Gb on a single sided double-layer disc.

«E»
Effect in PicturesToExe is any comment, transition, animation, pan, zoom and so on.
EXE-file is the common filename extention for denoting an executable file (a program) in different
operating systems. Besides the executable program itself, many EXE files contain other
components called resources, such as bitmaps and icons which the executable program may use
for its graphical user interface.
«F»
File is a block of arbitrary information, or resource for storing information, which is available to a
computer program and is usually based on some kind of durable storage. A file is durable in the
sense that it remains available for programs to use after the current program has finished.
Computer files can be considered as the modern counterpart of paper documents.
FPS (frames per second) is frame rate, or frame frequency, the measurement of the frequency
(rate) at which an imaging device produces unique consecutive images called frames. The term
applies equally well to computer graphics, video cameras, film cameras, and motion picture
systems. Frame rate is most often expressed in frames per second (fps) or simply hertz (Hz).
«H»
Hardware Acceleration is the use of hardware to perform some function faster than it is possible
in software running on the normal. Normally, processors are sequential, and instructions are
executed one by one. Various techniques are used to improve performance; hardware acceleration
is one of them. The main difference between hardware and software is concurrency, allowing
hardware to be much faster than software. Hardware accelerators are designed for computationally
intensive software code. Depending upon granularity, hardware acceleration can vary from a small
functional unit to a large functional block like motion estimation in MPEG2.
HD-1080 (High Definition) is the name for a category of display resolutions. The number "1080"
represents 1,080 lines of vertical resolution, while the letter p stands for progressive scan
(meaning the image is not interlaced). 1080p is considered a HDTV video mode. The term usually
assumes a widescreen aspect ratio of 16:9, implying a horizontal resolution of 1920 pixels. This
creates a frame resolution of 1920×1080 or 2,073,600 pixels in total. The frame rate in Hertz can
be either implied by the context or specified after the letter p, such as 1080p30, meaning 30 Hz.
HD-1280x720p is another high definition format, the difference with the previous format is in the
number of lines.
HSL is a related representation of points in an RGB color space, which attempt to describe
perceptual color relationships more accurately than RGB, while remaining computationally simple.
HSL stands for hue, saturation, lightness. HSL describes colors as points in a cylinder, whose
central axis ranges from black at the bottom to white at the top with neutral colors between them,
where angle around the axis corresponds to «hue», distance from the axis corresponds to
«saturation» and distance along the axis corresponds to «lightness».
«I»
Icon is (from Greek εἰκών, eikon, "image") is an image, picture, or representation; it is a sign or
likeness that stands for an object by signifying or representing it, or by analogy, as in semiotics; by
extension, icon is also used, particularly in modern popular culture, in the general sense of symbol
— i.e. a name, face, picture, edifice or even a person readily recognized as having some wellknown significance or embodying certain qualities.
ISO Image (.iso) is a disc image of an ISO 9660 file system. ISO 9660 is an international standard
originally devised for storing data on CD-ROM. More loosely, it refers to any optical disc image. As
is typical for disc images, in addition to the data files that are contained in the ISO image, it also
contains all the filesystem metadata, including boot code, structures, and attributes. All of this
information is contained in a single file. These properties make it an attractive alternative to
physical media or the distribution of software, that requires this additional information as it is simple
to retrieve over the Internet.

«J»
JPEG is a commonly used method of compression for photographic images. The name JPEG
stands for Joint Photographic Experts Group, the name of the committee that created the
standard. JPEG is distinct from MPEG (Moving Picture Experts Group), which produces
compression schemes for video. The JPEG standard specifies both the codec, which defines how
an image is compressed into a stream of bytes and decompressed back into an image, and the file
format used to contain that stream. The compression method is usually lossy compression,
meaning that some visual quality is lost in the process and cannot be restored, although there are
variations on the standard baseline JPEG that are lossless. There is also an interlaced
«Progressive JPEG» format, in which data is compressed in multiple passes of progressively
higher detail. This is ideal for large images that will be displayed whilst downloading over a slow
connection, allowing a reasonable preview after receiving only a portion of the data. However,
progressive JPEGs are not as widely supported.
«L»
Lossless Compression is a class of data compression algorithms, that allows the exact original
data to be reconstructed from the compressed data. This can be contrasted to lossy data
comression, which does not allow the exact original data to be reconstructed from the compressed
data. Lossless data compression is used in many applications. For example, it is used in the
popular ZIP file format and in the Unix tool gzip. It is also often used as a component within lossy
data compression technologies. Lossless compression is used when it is important that the original
and the decompressed data be identical, or when no assumption can be made on whether certain
deviation is uncritical.
«M»
Midi (Musical Instrument Digital Interface) is an industry-standard protocol that enables
electronic musical instruments and other equipment to communicate, control and synchronize with
each other. MIDI does not transmit an audio signal or media — it simply transmits digital data
"event messages" such as the pitch and intensity of musical notes to play, control signals for
parameters such as volume, vibrato and panning, cues and clock signals to set the tempo. As an
electronic protocol, it is notable for its success, both in its widespread adoption throughout the
industry, and in remaining essentially unchanged in the face of technological developments since
its introduction in 1983.
Mode is a distinct setting within a computer program or any physical machine interface, in which
the same user input will produce perceived different results than it would in other settings. The
best-known modal interface components are probably the Caps Lock and Insert keys on the
standard computer keyboard, both of which put the user's typing into a different mode after being
pressed, then return it to the regular mode after being re-pressed.
MPEG-1 defines a group of Audio and Video (AV) coding and compression standards agreed upon
by MPEG (Moving Picture Experts Group). MPEG-1 video is used by the Video CD (VCD)
format and less commonly by the DVD-video format. The quality at standard VCD resolution and
bitrate is near the quality and performance of a VHS tape. MPEG-1, Audio Layer 3 is the popular
audio format known as MP3.
MPEG-2 is a standard for "the generic coding of moving pictures and associated audio
information". It describes a combination of lossy video compression and lossy audio data
compression methods, which permit storage and transmission of movies using currently available
storage media and transmission bandwidth. MPEG-2 is widely used as the format of digital
television signals that are broadcast by terrestrial (over-the-air), cable and direct broadcast satellite
TV systems. It also specifies the format of movies and other programs that are distributed on DVD
and similar discs, such as TV stations, TV receivers, DVD players and other equipment are often
designed to this standard. MPEG-2 was the second of several standards developed by the Moving
Pictures Expert Group.
«N»
Navigation Bar (also known as links bar or link bar) is a subregion of a web page, that contains

hypertext links in order to navigate between the pages of a website. Since it usually appears on all
or at least on several pages of a website it is one of the key design-elements of websites.
NTSC is the analog television system in use in the United States, Canada, Japan, Mexico, the
Philippines, South Korea, Taiwan and some other countries, mostly in the Americas. It is named for
the National Television System Committee, the U.S. standardization body which adopted it.
«O»
Object in PicturesToExe is any image, file, frame, comment, text or button in the Object List.
OGG is an open standard for a free container format for digital multimedia, unrestricted by software
patents and designed for efficient streaming and manipulation. The name ‘Ogg’ refers to the file
format, which can multiplex a number of separate independent free and open source codecs for
audio, video, text (such as subtitles) and metadata. The term ‘Ogg’ is often used to refer to Audio
File Format OGG Vorbis, that is, Vorbis-encoded audio in the Ogg container.
Opacity is the state of being impenetrable to light. An opaque object is neither transparent
(allowing all light to pass through) nor translucent (allowing some light to pass through). When light
strikes an interface between two substances, some of the light is reflected, some is absorbed, and
the rest is transmitted.
«P»
PAL (Phase Alternating Line) is a colour encoding system used in broadcast television systems
in large parts of the world. Other common analog television systems are SECAM and NTSC. PAL
was developed by Walter Bruch at Telefunken in Germany. The format was first unveiled in 1963,
with the first broadcasts beginning in the United Kingdom and Germany in 1967.
PDF (Portable Document Format) is the file format, created by Adobe Systems in 1993 for
document exchange. PDF is fixed-layout document format used for representing two-dimensional
documents in a manner independent of the application software, hardware, and operating system.
Each PDF file encapsulates a complete description of a 2-D document (and with Acrobat 3-D,
embedded 3-D documents) that includes the text, fonts, images, and 2-D vector graphics, that
compose the document.
PNG (Portable Network Graphics) is a bitmapped image format, that employs lossless data
compression. PNG was created to improve upon and replace the GIF format, as an image-file
format not requiring a patent license. PNG supports palette-based (palettes of 24-bit RGB colors)
or greyscale or RGB images.
Preview may be where output of a particular document, page, film, etc. is displayed before it is
produced in its final form. In the case of printed material this is known as a print preview.
PTE is the abbreviation from PicturesToExe and is also the extension of projects, made in
PicturesToExe.
«R»
RGB is an additive colour model, in which red, green and blue light are added together in various
ways to reproduce a broad array of colours. The name of the model comes from the initials of the
three additive primary colours: red, green, and blue. The term RGBA is also used to mean Red,
Green, Blue, Alpha. This is not a different color model, but a representation; the Alpha is used for
transparency. The RGB colour model itself does not define what is meant by ‘red’, ‘green’ and
‘blue’ colorimetrically, and so the results of mixing them are not specified as exact, but relative.
Rotate is to move about an object in a circular motion. A two-dimensional object rotates around a
center of rotation. A three-dimensional object rotates around a line called an axis. If the axis of
rotation is within the body, the body is said to rotate upon itself, or spin.
«S»
Screensaver is a type of computer program initially designed to prevent «Phosphor Burn-in» on
computer monitors by blanking the screen or filling it with moving images or patterns when the
computer is not in use. Today, screensavers are also used for entertainment or security purposes.

SECAM (Séquentiel couleur à mémoire, French for «Sequential Color with Memory»), is an
analog color television system first used in France. A team led by Henri de France, working at
Compagnie Française de Télévision (later bought by Thompson), invented SECAM. It is,
historically, the first European color television standard.
Slide in PicturesToExe is the image, which you use in the project and can see on the screen.
Slide List is the list of images, which you use in the project.
Slide show is a display of a series of chosen images, which is done for artistic or instructional
purposes. It is becoming more common to see digital slideshows. Slideshows custom made for
people using their photos, music, wedding invitations, birth announcements, or virtually any other
documents that can be scanned. Some people are calling these DVD's the new photo montage or
DVD slideshows.
SVCD disc (the Super Video CD) standard upgrades the Video-CD format. It utilizes better Video
and Audio quality. It also standard includes extensions for surround sound multi-channel audio,
provisions for PC playback. It's also based on variable bit rate (VBR) MPEG-2 coding for more
efficient use of disc capacity. The bit rate is up to 2.6 Mbps.
«T»
Template, when used in the context of file format refers to a common feature of many software
applications, that define a unique file format intended specifically for that particular application.
Template file formats are those, whose file extensions indicates, that the file type is intended as a
starting point from which to create other files.
Thumbnails are reduced-size versions of pictures, used to make it easier to scan and recognize
them, serving the same role for images as a normal text index does for words.
Timeline is the presentation of time of images and music and their synchronization.
TV System (analog television system) includes several components: a set of technical parameters
for the broadcast signal, a system for encoding color, and possibly a system for encoding multichannel audio. In digital television all of these elements are combined in a single digital
transmission system.
«V»
Video Codec is a device or software, that enables video compression and/or decompression for
digital video. The compression usually employs lossy data compression. Historically, video was
stored as an analog signal on magnetic tape. Around the time when the compact disc entered the
market as a digital-format replacement for analog audio, it became feasible to also begin storing
and using video in digital form, and a variety of such technologies began to emerge.
VCD (also called video CD, video compact disc or "disc") is a format specifically designed to hold
MPEG-1 video data and to include interactive capabilities. VCD has a resolution similar to that of
VHS, which is far short of the resolution of DVD format. Each VCD disc holds 72-74 minutes of
video and the bit rate is 1.44 Mbps. VCDs can be played on a VCD player connected to a
television set (in the same way that video cassettes can on a VCR) or computer, on a CD player,
on some CD-ROM drives and some DVD players.
«W»
WAV (or WAVE) is an audio file format standard for storing audio on computers. It is the main
format used on Windows systems for raw audio. Though a WAV file can hold compressed audio,
the most common WAV format contains uncompressed audio in the pulse-code modulation PCM
format. PCM audio is the standard audio file format for CDs, containing two channels of 44,100
samples per second, 16 bits per sample. Since PCM uses an uncompressed, lossless storage
method, which keeps all the samples of an audio track, professional users or audio experts may
use the WAV format for maximum audio quality. WAV audio can also be edited and manipulated
with relative ease using software.
Waveform means the shape and form of a signal such as a wave moving in a solid, liquid or
gaseous medium. In many cases the medium in which the wave is being propagated does not

permit a direct visual image of the form. In these cases, the term «waveform» refers to the shape
of a graph of the varying quantity against time or distance.
WMV (Windows Media Video) is a compressed video file format for several proprietary codecs
developed by Microsoft. The original codec, known as WMV, was originally designed for Internet
streaming applications.
«Z»
ZIP is a file format, popular data compression and archival format. A ZIP file contains one or more
files that have been compressed, to reduce their file size, or stored as-is. The format was originally
designed by Phil Katz for PKZIP. However, many software utilties other than PKZIP itself are now
available to create, modify, or open (unzip, decompress) ZIP files.
Zoom is decreasing (narrowing) the apparent angle of view of a digital photographic or video
image. Digital zoom is accomplished by cropping an image down to a centered area with the same
aspect ratio as the original, and usually also interpolating the result back up to the pixel dimensions
of the original. It is accomplished electronically, without any adjustment of the camera's optics, and
no optical resoluton is gained in the process.
Most of the terms are taken from http://en.wikipedia.org.
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